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1. Combining PDFs in Acrobat Pro DC

1. Open Acrobat Professional DC. Make sure you are on the All tools menu in the upper left. Click
on Combine Files as shown in the red rectangle in Figure 1.

All tools

Create a PDE ﬁ: N\
.E

Combine files

Add files by clicking the button below or drag and drop them here.
E Edit a PDF You can also add the current open files from below:

4~ Exporta PDF

Add Open Files
“[] Organize pages
Help

@ Use print production :
Figure 2

() Prepare for accessibility

Figure 1

2. Next click on Add Files (Figure 2). Add the files in the order you want them to appear in
your final document (i.e., title page, template, appendices). Then click Combine in the upper
right. See Figure 3 below. If you accidentally add them in the wrong order and you have
already combined the files, you can go to Organize pages to move the thumbnail of the
page(s) in to the correct order. Remember to click Menu and Save As and title your
document appropriately. We recommend you name it using your last name and the date or a

version number.
D

Figure 3
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2. Embedding Fonts

1. Click on the All Tools menu in the top left of the screen. Click on Use Print Production.
See Figure 4 below.

Alltools  Edit  Convert  E-Sign € : :
€ Use print production
All tools x
i (¢ Output preview
ED  Combine files ltnlq Preflight
52 EditaPDF
[& Edit object
! Exporta PDF
o i (A Convert colors
[ use print production B Flattener preview
(% Prepare for accessibility
E’L Save as PDF/X
[2 sendforcomments

Figure 4 Figure 5

2. You should now see the screen in Figure 5. Click on Preflight.
3. Click on the Wrench icon indicated by the red arrow in Figure 6 shown below.

Preflight

|1/l Essentials ~
CﬁProfiles Results 4 Standards Options ~
Default '_I [9‘? ,Ol p] |

w Digital printing and online publishing
O /= Digital printing (B/W) Edit.. =~

Optimizes the current PDOF document for digital printing. Converts all
colors - including spot colors -to grayscale.

5 JC Digital printing [color)

» PDF analysis

¥ PDF fixups

ﬂ L Convert all pages into CMYK images and preserve text information
f} ,.K. Convert all pages into RGE images and preserve text information
ﬁ),&: Convert fonts to outlines

5 . Flatten annotations and form fields

j:) ,,i.« Flatten transparency (high resolution)

» PDF/fA

» PDFfUA

» PDF/X

» Prepress

feELiDEEOHo R p Analyzei w Analyze and fix!

Figure 6
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4. Next click the triangle next to Document. In the drop down, select Embed fonts
(even if text is invisible); see Figure 7 below. Click Fix indicated by the red arrow.
You will be asked to save the PDF. Name your document if you have not already

Preflight E

and click Save.

| |Ill Essentials ~
. Cﬁ Profiles Results - 4 Standards ptions ~
| ¥OE ul
» Color spaces, spot colors, inks

¥ Document
= ,ﬁ- Campress all uncompressed objects using lossless ZIP compression
@ JL Convert fonts to outlines

JL Embed fonts

If a PDF uses fonts which are not embedded into the PDF file they are
embedded. This fixup embeds fonts even if they are only used for text
which is invisible [text rendering mode 3). It is required that the
respective fonts are present in the system's font folders, Some fonts
may have a flag indicating that their license does not allow embedding.
In this case the fonts are not embedded into the PDF,

@ = Embed missing fonts

@ J Fix glyph width information

@ J& Recompress LZW as ZIP

» Document info and Metadata

b Interactive elements and properties

» Further Options

—— £ i

Figure 7

5. To check if this worked, go to Menu then Document properties. Click on the fonts tab.
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Document Properties -
Description  Security Fm Initial View Custom Advanoed
Fonts Used in this Decument
r
Type: TrueType (CID)
Encoding: Identity-H
Type: TrueType (CID)
Enceding: ldentity-H
= 7 A:ioI-Bnl:mulndd
Type: TrueType
Encoding: Built-in
= [ .ﬂnaI-deM
Type: TrueType
Enceding: Ansi
&[] Arial-BoldW(Embedded Subset)
Help [ [+ 4 Cancel
Figure 8



3. Creating Bookmarks

1. Click on the side bar on the right hand side of the program. Then click on the ribbon
bookmark indicated by the red square. See Figure9.

%  Bookmarks

Title Page
Table of Contents
Combining PDFs in Acrobat Pro DC

Embedding Fonts

Creating Bookmarks @

Setting the Document Properties
B
Edit PDF
Z Organize Pages
| Inserting Rich Media

@ Making Your Document Accessible

LaTeX and Accessibility

Figure 9 Assigning the Reading Order

Figure 10

2. Any bookmarks automatically created will be displayed like Figure 10. Next, click on the
Bookmark icon with the plus sign indicated by the red arrow.

3. Only first level headings are required to be bookmarked. Make sure you are at the top of
the page that the first level heading is located on. Type the name of that bookmark and
hit enter. If you accidentally create a bookmark or bookmark something that should not
be bookmarked, you can delete the bookmark by clicking the trash can next to that
bookmark.

4. Repeat steps 2 and 3 for each bookmark you create.
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4. Setting the Document Properties

1. In the upper left click Menu and Document properties as shown in Figure 11. Click the
Description tab. You should now see a screen like Figure 12, shown below.

- @ 17 acrobat_pro_inst Document Properties b |
open CtieO Dﬂ-ﬂ"ﬂf'ﬂ‘ Security Fonts  Initial View Custom  Advanced é_
Open racent files ¥ Description
Create ¥ File: acrobat_pro_instructions_june_2025 pdf
Combine files
Title: [Acrobat Professional DC Instructions
Save CirleS
Save as. Shift+Cirl+5 Author: |BGSU Thesis and Dissertation Sendces
Save as other >
Export 3 PDF » Subject: |ﬂ=°¢=1ibilii?
Protect Using Password ¥ - i
Keywaonds: accessibility; acrobat pro; embed fonts; document properties; bookmarks; tables; figures;
Reguest e-signatures summaries; alt text;
Share file
Brint CtilsP
Search »

Created: 1111672022 10:56:08 AM Additional Metadsta_

Modified: 5/30/2025 11:45:24 AM

Application:  Adobe Acrobat Pro DC (32-bit) 2212017

w

Undo, Redo & more

Advanced
Form Optiong »
View » PDF Producer:  Adobe Acrobat Pro DC (32-bit) 22120M7
Disable new Acrobat PDF version: 16 (Acrobat 7x)
Location:  C:iUsers\kileshiDesktoph
Windo -
ks File Size: 563 MB (5,965,401 Bytes)
Help >
Page Size: BSOx 110000 Number of Pages: 28
Preferences Cti=k
Protection & Tegged PDF:  Yes Fast Web View: Mo
Document?raperhes Ctri+D
Exit application Cirl+Q
—
. Help | oK 1 Cancel
Figure 11 J
Figure 12
Reading Options

Binding: | Left Edge -~

Language: | English ~

Figure 13

2. Fill in the correct information for the Title, Author, Subject and Keywords. Make sure to
separate the keywords with semi colons. Please type your title in either “Title Case” or
“Sentence Case”. This will allow you to copy and paste the information into OhioLINK
correctly. Once you have entered all the required information, click OK.

3. Next, click the Advanced tab indicated by the red arrow. Here you will set the language of
your document. See Figure 13.

4. Re-save this document to make sure all of the changes are incorporated into your final PDF.
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1. Click on the Alltools menu in the top left of the screen then click on Edit PDF. See

Figure 4, third item down. This figure is found on page 4.

2. You should now see Figure 14.

3. Text allows you to change a misspelled word or add text
like the heading for an appendix or a page number.

4. At the top (see yellow highlight) you can select the font,
font size, bold, italic, and underline.

5. The red arrow points to where you select the spacing
between the lines of text (e.g., single or double space).

6. Images allows you to add an image.

7. Link allows you to add an invisible box over a word or
phrase and insert a hyperlink. If you have a link and it
is not made accessible, you will need to remove it.

* Remember, Ctrl Z on a Windows machine or

Command Z on a Macintosh will allow you to undo
what you just did.
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FORMAT TEXT

Arial

L4

n

12 ‘N | =, IS,
Gy T T,

1= 120 v 1o v
T 100 v YA o ~
MODIFY PAGE

cC @ G

¥l Organize pages

ADD CONTENT

Ty Text

B3 Image

Bl Header and footer |
G Watermark

& Link

More

Figure 14
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5. To display the rulers, go to the upper left Menu and click View > Show/Hide >
Rulers & grids > Rulers (Figure 15).

EBlEE & +f scobat_pro_instuctions. ¥ | + Creste
Cpen ciri+0
Oipen recent files >
Create >
Compine files
Sgve as_ shift+Cirl+5
Save as other ¥
Export a PDF ¥
Protect Using Password
Reguest e-signatures
Share file
Print.. Cird+P
Search ]
Paste ey
Undo, Redo & maone ¥
View : Rotate wew ¥
Dasable new Acrobat e Gaviaion »
» Page display >
Window > Zoom »
Hejp » Read mode CirlsH
Preferepces._ Crle & Full screen mode Ctri+L
Los d ANt Hide ’ Customize toolbar
Document properties. CtrisD Display theme » Side parsals
Exit applicatoon Crl+Q Display size » :
Aead out loud » fz:::fi?mm anﬂ Cur+U
Tracker_ g Gid
Rulers [:? Cul+R
Guides
t] Line Weights Ctris5
Figure 15

6. To zoom in or out on a page, click the magnifiers on the bottom right of the screen
indicated by the red and green squares in Figure16 below.
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6. Organize Pages

1. If you find that you have pages that are out of order, go to All tools > Organize Pages
(Figure 17). You will see a thumbnail of each page in your document. Now you can
click on the page that you need to manipulate. The selected page will turn blue. Then
move the thumbnail of that page to the desired page order. If you hover over a page,
you will see a clockwise icon, counter clockwise icon, and trash can. To delete a page,
click the Trash Can. To rotate a page and make it landscape, click the appropriate
rotation icon (Figure 18). You can also delete blank pages. Remember to check your
page numbering when moving or removing a page.

i
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B e ===
Figure 17
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Figure 18
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7. Inserting Rich Media

1. To add audio or video into your PDF, you will use the Rich Media tool. Choose All tools >
More Options > All rich media (Figure 19). Then select the Video or Sound
(Figure 20). Drag or double-click to select the area on the page where you want the
video or sound to appear. Select the file on your computer that you want to add. Click OK.

B Addrich media Button
Figure 19 Hf video
) Sound
(7 3D media
Figure 20

Adobe Acrobat supports MP3, MOV, MP4, and other H.264 encoded files.
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8. Making Your Document Accessibile

Because your document will be online, you will need to make your document accessible.

1. Go to All tools > Prepare for accessibility (Figure 21). Once you click it, you will
see Figure 22's menu.

(% Prepare for accessibility

Figure 21

2. Click Check for accessibility (see highlight).

€ Prepare for accessibility

(& Automatically tag PDF

Change reading options
(E Check for accessibility
@E, Open accessibility report
G Identify form fields

B Add alternate text

% Use setup assistant

B¢ Fix reading order

Figure 22
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3. A new menu should now be on screen (Figure 23). Click Start Checking indicated by
the red arrow below.

Accessibility Checker Options >

Report Options

Create accessibility report Folder: C:\Usershkflesh\Documents

[] Attach report to document

Page Range

(® All pages in document () Pages from 1 to |1

Checking Options (27 of 32 in all categories)

Category: | Document -

Accessibility permission flag is set

Document is not image-only PDF

Document is tagged PDF

Document structure provides a logical reading order
Text language is specified

Document title is showing in title bar

Bookmarks are present in large documents

Document has appropriate color contrast

| Select All | ‘ Clear All

Show this dialeg when the Checker starts

Start Checking | | Cancel

Figure 23

BGSU. ‘ Graduate College 13

BOWLING GREEN STATE UNIVERSITY



x  Accessibility Checker
> Document (3 issues) 4. Once you Start Checking, you should see a
. Page Content (2 lssues) menu on the right glde of your screen S|mllgr to
(Figure 30). Each item that is bold has an issue.
> Forms Click on each of the arrows to view the list under
s Alterate Text (1 issue) each bold section. Sge Fig_ure 25 with an example
of the Document section's issues.
3 Tables
3 Lists
3 Headings
Figure 24
v Document (3 issues)

Accessibility permission flag - Passed
Image-only PDF - Passed
Tagged PDF - Passed
() Logical Reading Order - Needs manual check
Primary language - Passed
@ Title - Failed
A Bookmarks - Skipped
@ Color contrast - Needs manual check
v Page Content (3 issues)
> (&) Tegged content - Failed
> () Tegged annotations - Failed
3 @ Tab order - Failed

Character encoding - Passed

Figure 25
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5. Red X’s are bad. If you see a Yellow
Triangle with an explanation point (!),
please right click on the issue and un-
check Skip Rule. It should now show you
the issue that was skipped. Blue question
marks (?) need to be checked manually.



x  Accessibility Checker

~ Document (3 issues)

6. Right click on a red X area and you should see
a menu like shown in Figure 26. Click on Fix. If it
prompts you with another menu, Click OK.

Accessibility permission flag - Passed

Image-only PDF - Passed

Continue to do this on each red X section. Tagged PDF - Passed
() Logical Reading Order - Needs manual check
7. It is required that you add Alternate Text for Primary language - Passed
each picture, figure, table, or other object that is o ﬁ,ﬁ,_;_.
not text in your document. Click the drop down ey Fix
next to Alternate Text. Right click on the red X — Skip Rule
that shows Figures Alternate Text Failed. You L I i
should see a Pop Up screen like Figure 27. It will > Page

heck Again
go to the first object in your document. Where you 5 Fom i

see the yellow highlight, is where you will enter a
brief description of the object. Do not use “image
of’, “table of”, “graphic of” or the like when ¥ A
describing your object. You do not repeat > Lists
information that you have typed in your
paragraphs. Instead, explain the action in the
picture or purpose of the figure. Type that Figure 26
information up to 255 characters. This text is
something a screen reader would read to a person
who uses a screen reader or other assistive
program. Please keep your alternate text
accurate, succinct, and avoid redundancy. With
charts/figures, make sure to include the type of
chart (e.g., bar chart, scatter plot, pie chart, etc.).
With pictures, make sure to include the action or
the purpose of what is happening in the picture.
See our video about alt text.

Show Report

b Alterr Options

3 Headings

Set Alternate Text

4 Image 1 of 3

8. The right arrow indicated by the red circle in
Figure 27 is how you get to the next object. You
can go back using the left arrow. Make sure to
Save & Close once you have completed this
section. Do not select Decorative Figure for any Cancel
of the objects you add to your document. A
screen reader will ignore the items marked Figure 27
Decorative Figure. You included the item in your

document for a reason so please give it alt text.

Alternate text: [] Decorative figure

BGS| J | Graduate College 15
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8. When you see Tables in bold and click the triangle
next to it, Red X's will be next to each table issue.
Next to the Summary-Failed listing as shown in
Figure 28, you will not be able to fix this issue within
this menu. Clicking on each Element will take you to
each item that failed within your document. Click on
the first Element in the list. It will take you to the first
table that needs a summary.

9. Once you are on a page that contains a table that
needs a summary, click on Fix Reading Order from
the Accessibility menu displayed on the left side of
the document as shown in Figure 29. This will create
a pop-up window (Figure 30) that you can click and
drag to the side of the screen for the moment.

Reading Order

Draw a rectangle around the content then click one of
the buttons below:

Text/Paragraph Figure
Form Field Figure/Caption
Heading 1 Heading 4 Takle
Heading 2 Heading 5 Cell
Heading 3 Heading 6 Formula
Reference (g) Mote (z) Background/Artifact
Table Editor
@ show page content groups | |
(o] Page content order
OStructure types
B show table cells | |

B Display like elements ina single block

8 show tables and figures |
Clear Page Structure_. Show Order Panel
Help Close
Figure 30
BGSLJ. | Graduate College o
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~ @ Summary - Failed
Element 1
Element 2

Element 3

Figure 28

€ Prepare for accessibility

[a Automatically tag PDF

@ Check for accessibility
(‘_-fﬁ Open accessibility report
[:4 Identify form fields

E Add alternate text

% Use setup assistant

Ef Fix reading order

Figure 29



Erros
Rectangle


a}:mupcnsuy Score Model Correctly Specified, e ~ y& n=1000

10. Note the table displayed in the document e T T A
that is grayed out with a large x across it like Eimaor | NBias  RMSE | Biss  RMSE | Bias AMSE
the table shown in Figure 31. nght click on 7 0002 V0868 | 00170 002828 | D.0pA53 080146
the black rectangle that says Table in the i Sﬁ%\ﬁ% 000513 008563 Y001 15T

figrza | 000394  0.07 001437 16704
upper left corner of the table. From the menu fanzs | 000303 0.0247 909 | 001345 15081

. i Rz L0015 L0362 032 .012 5

that appears, select Edit Table Summary. om | Go0is1 010871 | 0985y 00035 | o010 123914

frrze | -0.00267 0.76238 | -0 0.60043 | 0.00774 0.89486

fEL 0.00392 0.02263 .03303 | -0.01717  1.22545
figLa 0.00417  0.02264 A -0.02690 1.03877
figLa 5 0.00771  0.89476

0.01106

frEL 0.00157 001717 1.22545
fiTEL2 0.00288 0.03208

ATELs 0.01106  0.03479 | 0.

fraELt -0.00625 0.03295 | -0.

fapra -0.00490 0.03199 | -0.

ParErs 00415 0.02262 | 0.00310 0.03454 | A

fapry” | 000586 0.02264 | 0.00113 0.03301 | -0.01998
figpfa, | 000612 0.02265 | 0.00249 0.03207 | -0.02898
apra, | 000712 0.02271 | 0.01051 0.03476 | 0.00548 0.89307

11. This brings up a box like the one seen in Figure 31
Figure 32 for you to summarize the table in.
Type in your description of the table then click
OK. Make sure to include how many rows and
how many columns are in the table. If you are
counting the header row then say "including Table Summary
header row" when stating how many rows and

columns. Click OK. You will need to repeat Table Summary:

these steps for each table flagged by the |
Accessibility Checker.

Figure 32

Creating Accessible Tables

Include a title
Include a header row
Do not split or merge any cells
Do not leave a row or column blank
o Blank cells is not recommended because the screen reader
may skip over the blank cell or misinterpret them
o We recommend to fill the cell with relevant data, "N/A", or "0"
¢ Do not create nested cells/tables
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https://www.youtube.com/watch?v=oLY9kX4qpWM
https://www.youtube.com/watch?v=rnIX8HrYemE

Once the Table Summary is complete, right click again on the black rectangle that
says Table in the upper left corner of the table (Figure 31). From the menu that
appears, select Table Editor. Each cell is either Table Data (TD) or Table Header
(TH). All tables are required to have the Table Header row identified. See Figure 33.

TrVitter Categories o [Kev Terms HTeEquency
|y — D ative, Nazis, politics, W12
agne Hypocrisy Provocative, Nazis. polifics. 12

Streisand effect. backfired

J—@sﬁng the Protests = Ppolitical symbols, Bella Ciao. 5
ejection. walkouts.
#AUmtedFront

Figure 33

Click on a cell and you will see that the TH cells are now pink, and the TD cells are
gray. Right click on a cell and you will see this menu in Figure 34. Click on Table
Cell Properties. If the table headers cell says TD, change it to TH. Creating the
TH cells is how you identify the Table Header row.

THVitter Categories o JKey Terms

Table Cell Pr ties... = =
@ TR R e. Nazis, politics,

Table Editor Options...
ffect. backfired
Auto Generate Header Cell 1Ds

i ST arsymbols. Bella Ciao,

[TH

Figure 34

We recommend this YouTube video to show you what we describe in this document.

BGSL| ) | Graduate College 18

BOWLING GREEN STATE UNIVERSITY


https://www.youtube.com/watch?v=Bd8RRxCQPLg
Kimberly Fleshman
Cross-Out


PDFs created from LaTeX are not automatically read by Adobe Acrobat Pro in a
way that is accessible. You will need to take additional steps to make your

document accessible.
1. First, while LaTeX PDFs fill in the Document properties for you, you will still need

to manually remove the quotation marks around the keywords.

2. Next, remember to never Autotag (Automatically tag PDF) your document. It will
cause odd characters in your equations.

3. If your equations are not coming up as accessible, please try this Compatible
with Math ML and LaTeX web page. You put in the equation and it gives you
the accessible code.

19
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https://demo.wiris.com/mathtype/en/developers.php#mathml-latex
https://demo.wiris.com/mathtype/en/developers.php#mathml-latex

Screen readers need to be told how to read documents.
BGSU requires that your figures, tables, and 15tlevel
headings in your PDF are identified as such. While
Acrobat may translate these details without error, it may
make errors that you need to correct. If you receive a
Tagged content error on your Accessibility Check
(Figure 35), Acrobat recognizes that there are unlabeled
elements on a page. You will need to label them
manually.

1. First click on the Element that is an issue (Figure 35).
This will take you to the problem in the document.

2. Now on the left of the screen select Fix reading
order.(Figure 36).

3. The pop-up menu is movable by dragging it around on the screen. You will need to

Accessibility Checker X
G~

> Document

v Page Content (2 issues)

v @ Tagged content - Failed

Element 1

Figure 35

[Q“} Automatically tag PDF

Change reading options
@ Check for accessibility
@f;" Open accessibility report
[ Identify form fields

B Add alternate text

% Use setup assistant

E;‘,' Fix reading order

Figure 36

be able to see the page of your document and the pop-up. It may be beneficial for
you to move it to the side, as seen in the example below in Figure 37.

20
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Reading Order [ <]
Draw a rectangle around the content then click one of .
the buttons below:

Table Editor

{8 Show page content groups |

© Page content order

O structure types
) show table cells ]
8 Displey like clements in & single block.

= = " Adobe Acrobat Professional

Clear Page Structure ‘Show Qrder Panel

- Document Cloud (DC)
.

Figure 37

4. Next to the pop-up menu, you can see how Acrobat is currently reading that page
of the document. All text should be contained within a black box with a number
above. Figures and tables should be in a similar black box with an X going across
them. If the figure has had alternate text assigned to it, you can see the beginning
of the alternate text, as well.

5. If you need to assign/reassign a portion of the page, click and hold at the corner of
the area you wish to highlight. While holding the left mouse button, pull the
mouse to draw a box around that section of the page. Once you release the
mouse, this will put purple/magenta boxes around everything that has been
selected (Figure 38).

[2)DFs created from LaTeX are not automatically read by Adobe Acrobat Pro in a
way that is acoessnble You will need to take additional steps to make your

Figure 38

21

BGS| ) | Graduate College

BOWLING GREEN STATE UNIVERSITY



This selection feature can choose anything visible on the page, even if it is
already labeled something else. You will then need to select what you want to
identify this as from the Reading Order menu, seen in Figure 39.

e Text/Paragraph is for regular text in a

dOCU ment Draw a rectangle around the content then click one of the

. . . buttons below: %]
e Figure is for images.

e Figure/Caption is for images with their festpersarah rowre
captions (in a single block). Form Field FlouelCaption

e The different Heading choices are for each eadne redned e
level of headings. Heading 2 Heading 5 Cell

e Table is for tables (be sure to include the esdne eadnas e
table’s title in thIS) Reference Note Background/Artifact

e Formula is for math equations.

e Reference is for citations in footnotes only - Show page content roune -
(the ones at the end of your paper are 5 Page content arder
Text/Paragraph). Structurs types

e Note is for footnotes/endnotes that are not G el el u
CltatIOI"IS v Display like elements in a single block

. . v Show tables and figures ||

e Background/Artifact is for items you want
the screen reader to ignore completely. cleer Page Siueture.. show orderpenel
DO NOT USE THIS OPTION! Help Close

¢ You should not use the Cell option. Figure 39

Everything on the page should be identified as one of these items. The required
tags are Table, Figure, Text/Paragraph, and Heading 1 (H1).

If you would like to remove all tags from a page and to label all of the elements
manually, you can also choose Clear Page Structure.

22
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Setting 15t level headings
If your headings were identified in Microsoft Word, it is likely they will carry over to

your PDF. If you use LaTeX or did not properly identify them in Word, you may need
to set them manually.

B % ®8 Q @ 10 M OO = - R

| Accessibility

] e NG T Ve OF T AN (RING GRS
MANAGEMENT TO] R ANLLUSON oF LiBERAL FROIGRESN 199¢kors] |

Since s formation in 1927, the Academy of Motion Picture Arts and Sciences (AMPAS)

has been the subject of

\adoing, ranging from legal to ethical, mostly well-documented by Oscar

within the organization.

In order to provid of Tanalyzed

the Academy’s archives of y rule books in tandem to

W voting habits. My between the

organization’s stated i d Though the

that

Targue that

the Academy’s are incongruous with their track record, which suggests that instead of
——————————————————————————

Figure 40

1. As described above, find a page that needs to be adjusted. Draw a box
around the text by hold-clicking and pulling the box around the text you want
to identify. After letting go, verify that the text you wish to label is surrounded
by purple/magenta boxes (Figure 40).

2. Click Heading 1 in the Reading Order as seen in Figure 41. Once you click
Heading 1, it will put a new grey box around the text with a number. You can

keep this pop-up menu open and scroll to the next page you need to fix. Then
repeat steps 1 and 2.

Reading Order

Draw a rectangle around the content then click one of the

1
buttons below: ‘%
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3. Once you have made sure all 1% level headings are labeled properly, select Close
(Figure 43).

Draw a rectangle around the content then click one of the
buttons below: %l
Text/Paragraph Figure
Form Field Figure/Caption
Heading 1 Heading 4 Table
Heading 2 Heading 5 Cell

Heading 3 Heading 6 Formula

Reference Note Background/Artifact

v Show page content groups [ |
* Page content order
Structure types
v Show table cells ||
v Display like elements in a single block

v Show tables and figures [ |

Clear Page Structure... Show Order Panel

Help
Figure 43

BGSU and OhioLINK only requires that you label your first level headings
(ABSTRACT, ACKNOWLEDGMENTS, TABLE OF CONTENTS, each LIST, each
CHAPTER or their equivalents (e.g., INTRODUCTION, METHODS RESULTS,
DISCUSSION, CONCLUSION), REFERENCES/WORKS CITED/BIBLIOGRAPHY,
and each APPENDIX). If you do choose to label other headings, 2" level headings
should be labeled Heading 2, 3™ level headings should be labeled Heading 3, etc.
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